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І. Аннотация 

1. Цель и задачи дисциплины 

Целью освоения дисциплины является: 

изучение принципов компьютерной визуализации графических объектов. 

Задачами освоения дисциплины являются: 

 привить знания о технических способах визуализации изображения в 

современных графических устройствах, а также основах представления 

графической информации на персональном компьютере; 

 изучить теоретические основы двумерных и пространственных 

преобразований графических объектов, основы построения ряда базовых 

алгоритмов компьютерной графики; 

  ознакомление с различными форматами представления графической 

информации 

 Ознакомление с реализацией алгоритмов компьютерной графики 

 

2. Место дисциплины в структуре ООП 

Дисциплина «Основы компьютерной графики» изучается в модуле 

Информационные технологии Блока 1. Дисциплины обязательной части учебного 

плана ООП. 

Требования к «входным знаниям» и уровню начальной подготовки 

обучающегося для успешного освоения дисциплины включают знания: 

 Линейной алгебры 

 Математического анализа 

Освоение дисциплины будет основой для таких курсов, как «Основы 

аддитивных технологий», «Основы цифровой экономики», а также для 

прохождения практик и выполнения выпускной квалификационной работы. 

 
3. Объем дисциплины: 2 зачетных единицы, 72 академических часа, в том 

числе: 



контактная аудиторная работа: практические занятия 34 часа; 

самостоятельная работа: 38 часов. 

 
 

4. Планируемые результаты обучения по дисциплине, 

соотнесенные с планируемыми результатами освоения 

образовательной программы 

Планируемые результаты 

освоения образовательной 

программы 

(формируемые компетенции) 

Планируемые результаты обучения по 
дисциплине 

УК-1. Способен осуществлять поиск, 
критический анализ и синтез информации, 
применять системный подход для 
решения поставленных задач 

УК-1.1. Анализирует задачу, выделяя ее 
базовые составляющие; 
УК-1.5. Рассматривает и предлагает 
возможные варианты решения 
поставленной задачи, оценивая их 
достоинства и недостатки. 

ПК-1. Выполняет анализ
 результатов технологических 
исследований продуктов. 

ПК-1.3. Анализирует результаты 
технологических исследований. 

 
5. Форма промежуточной аттестации и семестр прохождения 

Зачет в 5 семестре. 

6. Язык преподавания: русский. 
 

II. Содержание дисциплины, структурированное по темам  с указанием отведенного на 

них количества академических часов и видов учебных занятий 

1. Для студентов очной формы обучения 

Учебная программа – 

наименование 

разделов и тем 

Всего 

(час.) 

Контактная работа (час.) Самостоятельная 

работа (час.) Лекции Практические 

(лабораторные) 

занятия 

Основные понятия 

теории цепей. 

2 1  1 

Принципы работы в 

САПР OrCAD16.5. 

Знакомство с 

методами 

моделирования 

работы электронных 

схем. 

6  4 2 

Цепи постоянного 

тока. Метод расчёта. 

4 2  2 



Создание условных 

графических 

изображений 

компонентов 

16  8 8 

Цепи с 

гармоническим 

воздействием. Метод 

расчёта. 

4 2  2 

Синтез электрической 

принципиальной 

схемы 

16  8 8 

Полупроводники и 

полупроводниковые 

приборы. 

5 3  2 

Усилители на 

биполярных 

транзисторах. 

5 3  2 

Операционные 

усилители и схемы на 

их основе. 

5 3  2 

Создание и 

трассировка печатной 

платы электронного 

узла 

16  8 8 

Индивидуальные 

задания 

18  10 8 

Введение в цифровую 

электронику. 

3 1  2 

Комбинаторные 

схемы.  

4 2  2 

Последовательные 

схемы 

4 2  2 

ИТОГО 108 19 38 51 

 

2. Для студентов заочной формы обучения  
 

III. Перечень учебно-методического обеспечения для самостоятельной работы 

обучающихся по дисциплине  

Примерный перечень, который может быть включен в раздел:  

– лабораторный практикум; 

– методические рекомендации по организации самостоятельной работы студентов; 

– Требования к рейтинг-контролю. 

 

IV. Фонд оценочных средств для проведения промежуточной аттестации 

обучающихся по дисциплине  

Форма проведения зачета: студенты, освоившие программу курса могут получить зачет 

по итогам семестровой и полусеместровой рейтинговой аттестации согласно «Положению 

о рейтинговой системе обучения ТвГУ» (протокол №8 от 30 апреля 2020 г.).  

Если условия «Положения о рейтинговой системе …» не выполнены, то зачет сдается 

согласно «Положению о промежуточной аттестации (экзаменах и зачетах) обучающихся 

по программам высшего образования ТвГУ» (протокол №11 от 28 апреля 2021 г.) 



1. Типовые контрольные задания для проверки уровня сформированности 

компетенции ОПК-2: способность использовать инструментальные средства (пакеты 

прикладных программ) для решения прикладных инженерно-технических и технико-

экономических задач, планирования и проведения работ по проекту. 

Этап 

формирования 

компетенции, в 

котором участвует 

дисциплина 

Типовые контрольные 

задания для оценки 

знаний, умений, 

навыков 

Показатели и критерии оценивания 

компетенции, шкала оценивания 

Начальный,  

владеть 

Спроектировать 

усилитель с общим 

эмиттером 

Создание проекта в программе Capture 

с помощью преподавателя – 1 балл; 

Неуверенное создание электрической 

принципиальной схемы в программе 

Capture – 1 балл; 

Выполнение расчёта значений 

компонентов схемы с двумя и более 

ошибками  – 1 балл; 

Создание профиля моделирования 

схемы с неподходящими значениями 

параметров  – 1 балл; 

Моделирование амплитудно-

частотных характеристик схемы 

выполнен с двумя и более ошибками – 

1 балл; 

Подбор корпусов компонентов 

выполнен с двумя и более ошибками – 

1 балл; 

Выполнено экспортирование схемы в 

программу PCBEditor – 1 балл; 

Расположение компонентов на 

печатной плате выполнено неуверенно 

PCBEditor – 1 балл; 

Трассировка печатной платы 

выполнена в двумя и более ошибками 

– 1 балл. 

Начальный,  уметь Моделирование работы 

схемы усилителя с общим 

эмиттером 

Создание проекта в программе Capture 

с помощью преподавателя – 1 балл; 

Неуверенное создание электрической 

принципиальной схемы в программе 

Capture – 1 балл; 

Создание профиля моделирования 

схемы с неподходящими значениями 

параметров  – 1 балл; 

Моделирование амплитудно-

частотных характеристик схемы 

выполнен с двумя и более ошибками – 

1 балл; 

 

Начальный, знать Составить схему 

усилителя с общим 

эмиттером и рассчитать 

значения её компонентов. 

Составление схемы с двумя и более 

ошибками – 1 балл; 

Выполнение алгоритма расчёта схемы 

с двумя и более ошибками – 1 балл; 

Выполнение амплитудно-частотного 



анализа схемы с двумя и более 

ошибками – 1 балл. 

2. Типовые контрольные задания для проверки уровня сформированности 

компетенции ПК-2: способность использовать инструментальные средства (пакеты 

прикладных программ) для решения прикладных инженерно-технических и технико-

экономических задач, планирования и проведения работ по проекту. 

Этап 

формирования 

компетенции, в 

котором участвует 

дисциплина 

Типовые контрольные 

задания для оценки 

знаний, умений, 

навыков 

Показатели и критерии оценивания 

компетенции, шкала оценивания 

Начальный,  

владеть 

Спроектировать 

усилитель с общим 

эмиттером 

Создание проекта в программе Capture 

с помощью преподавателя – 1 балл; 

Неуверенное создание электрической 

принципиальной схемы в программе 

Capture – 1 балл; 

Выполнение расчёта значений 

компонентов схемы с двумя и более 

ошибками  – 1 балл; 

Создание профиля моделирования 

схемы с неподходящими значениями 

параметров  – 1 балл; 

Моделирование амплитудно-

частотных характеристик схемы 

выполнен с двумя и более ошибками – 

1 балл; 

Подбор корпусов компонентов 

выполнен с двумя и более ошибками – 

1 балл; 

Выполнено экспортирование схемы в 

программу PCBEditor – 1 балл; 

Расположение компонентов на 

печатной плате выполнено неуверенно 

PCBEditor – 1 балл; 

Трассировка печатной платы 

выполнена в двумя и более ошибками 

– 1 балл. 

Начальный,  уметь Моделирование работы 

схемы усилителя с общим 

эмиттером 

Создание проекта в программе Capture 

с помощью преподавателя – 1 балл; 

Неуверенное создание электрической 

принципиальной схемы в программе 

Capture – 1 балл; 

Создание профиля моделирования 

схемы с неподходящими значениями 

параметров  – 1 балл; 

Моделирование амплитудно-

частотных характеристик схемы 

выполнен с двумя и более ошибками – 

1 балл; 

 

Начальный, знать Составить схему 

усилителя с общим 

эмиттером и рассчитать 

Составление схемы с двумя и более 

ошибками – 1 балл; 

Выполнение алгоритма расчёта схемы 



значения её компонентов. с двумя и более ошибками – 1 балл; 

Выполнение амплитудно-частотного 

анализа схемы с двумя и более 

ошибками – 1 балл. 

 

3. Типовые контрольные задания для проверки уровня сформированности 

компетенции ПК-11:  способность готовить презентации, научно-технические отчеты по 

результатам выполненной работы, оформлять результаты исследований в виде статей и 

докладов. 

Этап 

формирования 

компетенции, в 

котором участвует 

дисциплина 

Типовые контрольные 

задания для оценки 

знаний, умений, 

навыков 

Показатели и критерии оценивания 

компетенции, шкала оценивания 

Промежуточный, 

владеть 

Не предусмотрен  

Промежуточный, 

уметь 

Создать презентацию 

представляющую этапы 

проектирования усилителя 

с общим эмиттером. 

Лаконичность названия презентации и 

отдельных слайдов – 1 балл; 

Соответствие заголовков слайдов 

содержанию – 1 балл; 

Представлена принципиальная схема с 

указанием обозначений и 

номинальных значения её элементов – 

2 балла; 

Представлена амплитудно-частотная 

характеристика с  верно заданным 

частотным  диапазоном – 2 балла; 

Представлено изображение печатной 

платы отдельно верха и низа – 2 балла. 

Промежуточный, 

знать 

Нарисовать обозначение 

биполярных транзисторов. 

Правильно нарисован npn-транзистор 

и указано названия выводов – 2 балла; 

Правильно нарисован pnp-транзистор 

и указано названия выводов – 2 балла; 

Представлено буквенно-числовое 

обозначение транзисторов – 1 балл. 

 

V. Перечень основной и дополнительной учебной литературы, необходимой для освоения 

дисциплины  

а) Основная литература: 

1. Майстренко А.В.  Информационные технологии в науке, образовании и инженерной 

практике / А. В. Майстренко, Н. Майстренко; А.В. Майстренко; Майстренко Н. В. - 

Тамбов : Издательство ФГБОУ ВПО «ТГТУ», 2014. - 97 с. Режим доступа: 

http://biblioclub.ru/index.php?page=book&id=277993 

2. Чекмарев А. А. Инженерная графика. Машиностроительное черчение: Учебник / А.А. 

Чекмарев. - М.: НИЦ Инфра-М, 2013. - 396 с.: 60x90 1/16. - (Высшее образование: 

Бакалавриат). (переплет) ISBN 978-5-16-003571-0. Режим доступа: 

http://www.znanium.com/bookread.php?book=395430 

 

б) Дополнительная литература: 

1. Василенко Е. А. Техническая графика : Учебник . - Москва : ООО "Научно-

издательский центр ИНФРА-М", 2015. - 271 с. -. - ISBN 978-5-16-005145-1. 

Режим доступа: http://znanium.com/go.php?id=363575 



2. Изюмов А.А. Компьютерные технологии в науке и образовании / А. А. Изюмов, В. 

Коцубинский; А.А. Изюмов; Коцубинский В. П. - Томск : Эль Контент, 2012. - 150 с. - 

ISBN 978-5-4332-0024-1.                   

Режим доступа: http://biblioclub.ru/index.php?page=book&id=208648 

 

VI. Перечень ресурсов информационно-телекоммуникационной сети «Интернет», 

необходимых для освоения дисциплины  

Научная библиотека ТвГУ: http://library.tversu.ru/ 

Электронная библиотека издательства Лань: http://e.lanbook.com/ 

Университетская библиотека ONLINE: http://www.biblioclub.ru/ 

Сайт издательского дома ЮРАЙТ: http://www.biblio-online.ru/ 

 

VII. Методические указания для обучающихся по освоению дисциплины 
Лабораторный практикум  

Лабораторная работа №1 

Создание условных графических изображений (УГО) компонентов 

1. Цель работы  

Получить практические навыки по созданию УГО компонентов с помощью программы 

OrCAD Capture.  

2. Порядок выполнения работы  

2.1. Изучить описание редактора компонентов OrCAD Capture и порядок создания УГО 

компонентов.  

2.2. Получить у преподавателя задание для выполнения практической части работы.  

2.3. Создать библиотеку УГО всех необходимых компонентов.  

2.4. Продемонстрировать результат работы преподавателю и защитить её.  

  

2. Контрольные вопросы  

1. Какие параметры сетки можно изменить и с помощью каких команд?  

2. Можно ли для уже существующего проекта или индивидуальной схемы изменить шаг 

сетки?  

3. Можно ли установить фиксированное расстояние между выводами компонентов 

независимо от установленного шага сетки? 

4. Каким образом можно сделать невидимыми на схеме имена и номера выводов 

компонента?  

5. Какая команда позволяет разместить сразу несколько выводов при создании 

компонента. Какие параметры требуется указать при выполнении этой команды?  

6. Как изменить форму вывода (Shape) и тип вывода (Type) для созданного компонента?  

7. С помощью какой команды можно просмотреть и отредактировать свойства условного 

графического обозначения (Part Properties) уже созданного компонента?  

8. Каким образом можно просмотреть и при необходимости отредактировать все секции 

составного компонента?  

9. Должны ли совпадать имена соответствующих выводов питания для всех компонентов, 

которые их имеют?  

10. С помощью каких команд можно отредактировать значение атрибута <Value> 

компонента. Можно ли сделать данный атрибут невидимым на схеме?  

Лабораторная работа №2 

Синтез электрической принципиальной схемы 

1. Цель работы  

Получить практические навыки по созданию принципиальной схемы с помощью 

программы OrCAD Capture.  

2. Порядок выполнения работы  

2.1. Изучить описание редактора схем OrCAD Capture и порядок синтеза электрической 

принципиальной схемы.  

http://e.lanbook.com/
http://www.biblioclub.ru/
http://www.biblio-online.ru/


2.2. Синтезировать электрическую принципиальную схему.  

2.3. Продемонстрировать результат работы преподавателю и защитить её.  

3. Контрольные вопросы  

1. Каким образом в процессе установки сложных многосекционных компонентов на схему 

можно выбирать номер размещаемой секции компонента?  

2. С помощью какой команды можно выполнить автоматическую простановку 

позиционных обозначений компонентов?  

3. Каким образом можно просмотреть и при необходимости отредактировать свойства 

компонента с помощью Property Editor? Какие свойства компонента можно изменить с его 

помощью?  

4. Какие требования налагаются на имена размещённых на схеме символов питания  

и земли?  

5. Каким образом можно удалить размещённый на схеме символ “нет coединения”?  

6. С помощью каких команд можно убрать символ “пересечения проводников”?  

7. В шину входят цепи с именами Net1, Net2 … Net36. Каким должно быть имя шины в 

этом случае? С помощью какой команды оно вводится?  

8. С помощью какой команды можно осуществить проверку принципиальной схемы?  

9. С помощью каких опций осуществляется установка правил проверки принципиальной 

схемы?  

10. В каком формате должен создаваться список связей для проектирования печатной 

платы с помощью OrCAD Layout?  

Лабораторная работа №3 

Создание и трассировка печатной платы электронного узла 

1. Цель работы  

Получить практические навыки по созданию печатной платы электронного узла с 

помощью пакета программ OrCAD 16.5.  

2. Порядок выполнения работы  

2.1. Изучить описание редактора печатных плат и порядок создания печатной платы с 

помощью программы OrCAD Layout.  

2.2. Создать и растрассировать печатную плату.  

2.3. Продемонстрировать результат работы преподавателю и защитить её.  

3. Контрольные вопросы  

1. В какой последовательности осуществляется загрузка списка связей и создание новой 

печатной платы?  

2. Что собой представляет технологический шаблон печатной платы (файлы *.tch)?  

3. С помощью каких команд можно осуществить размещение компонентов на печатной 

плате?  

4. Для чего необходим контур печатной платы? С помощью какой команды он вводится?  

5. Можно ли запретить трассировку определённых цепей на определённых слоях?  

6. Каким образом можно установить необходимое количество слоёв печатной  

платы?  

7. Какие параметры печатных проводников ( цепей) нужно установить перед  

трассировкой?  

8. С помощью какой команды осуществляется автоматическая трассировка печатной 

платы в программе Layout Plus? Имеется ли возможность ручной трассировки?  

9. Какова последовательность действий при трассировке печатной платы с помощью 

программы SmartRoute?  

10. Как проверить соответствие конструкторско-технологическим ограничениям 

полученного проекта? 

 

Методические рекомендации по организации самостоятельной работы студентов 1. 

ВВЕДЕНИЕ 

Главные приложения OrCAD: 



 Capture – используется для создания принципиальных схем. 

 PSpice – моделирует работу схемы, созданной в Capture. Графики результатов 

моделирования отображаются в отдельном приложении Probe. 

 PCB Editor (Allegro) – используется для создания и трассировки печатных плат. 

Имеет систему автоматической трассировки дорожек между компонентами PCB. 

 

1.1. Библиотеки, файлы, папки и правила проекта. 

Электронные компоненты (резисторы, конденсаторы, микросхемы и т.д.) в OrCAD 

включают в себя три модуля, соответствующие указанным выше трем приложениям: 

 Электрический символ, которым компонент отображается на принципиальной 

схеме в Capure. 

 Электрическая модель – позволяет моделировать работу компонента в PSpice. 

 Корпус – в OrCAD он называется Footprint – отображает физические размеры и 

форму контактных площадок на плате (pads), к которым припаиваются выводы (pins) 

компонента. Используется для создания платы в PCBEditor. 

 

Правила проекта требуются при создании PCB. Основные правила касаются 

минимальной ширины дорожек (tracks) на плате и зазоров (gaps) между ними. В качестве 

единиц измерения используются mils, соответствующие тысячной доли дюйма (inch): 1 

mils = 1inch/1000. 

 

2. УСИЛИТЕЛЬ НА ОДНОМ ТРАНЗИСТОРЕ: ПРОСТОЙ АНАЛИЗ 

На рисунке показана схема простого усилителя на одном транзисторе. Он предназначен 

для усиления сигналов в аудио диапазоне 20 Гц – 20 кГц. 

Вначале, найдем точку покоя  (bias point) или рабочую точку, т. е. условия, когда на схему 

не подается входной сигнал и схема находится «в покое». 

1. Резисторы R1 и R2 образуют простой делитель напряжения, если не учитывать 

другие компоненты подключенные к ним. Вычислите напряжение на базе транзистора Q1. 

2. Транзисторный переход база–эмиттер работает как диод, включенный в прямом 

направлении, следовательно, падение напряжения на нем составляет 0,7 В. Зная это, 

можно вычислить напряжение на эмиттере. 

3. Теперь мы знаем падение напряжения на резисторе R4 и можем вычислить текущий 

через него ток. 

4. Ток, текущий через базу транзистора, много меньше токов через коллектор и 

эмиттер, поэтому ток, втекающий в коллектор, примерно равен току, вытекающему из 

эмиттера. Вычислите падение напряжения на резисторе R3 и напряжение на коллекторе. 

Теперь разберемся, зачем в схеме нужны конденсаторы. По какой формуле определяется 

импеданс конденсатора (помните, что это комплексная величина), и как его величина 

зависит от частоты. Конденсаторы в данной схеме обеспечивают пропускание 



высокочастотных сигналов, которые мы хотим усилить, но блокируют постоянную 

составляющую напряжения, устанавливающую рабочую точку. 

 Как мы видим, с помощью делителя напряжений на базе транзистора 

устанавливается определенной напряжение, определяющее его рабочую точку. 

Конденсатор С1 на входе схемы блокирует постоянную составляющую напряжения от 

предыдущего каскада, пропуская полезный переменный сигнал.  

 Посмотрим как входной сигнал проходит через схему. Он проходит «через» 

конденсатор С1, переход база–эмиттер транзистора, параллельно соединенные R4 и C2 и 

возвращается на вход через землю. Только та часть напряжения, что падает на переходе 

база–эмиттер, дает вклад в усиление, все остальное – потери, которые следует свести к 

минимуму. Это значит, что нам бы хотелось убрать резистор R4, но этого сделать нельзя, 

т. к. данный резистор устанавливает рабочую точку – он определяет ток через транзистор, 

как мы видели выше в п.3. 

Чтобы решить эту проблему, конденсатор C2 подключен параллельно резистору R4. 

Постоянное напряжение (определяющее рабочую точку) имеет нулевую частоту и 

полностью падает на резисторе. Входной высокочастотный сигнал проходит в основном 

через конденсатор, импеданс которого должен быть меньше, чем у резистора.    

В идеале импеданс конденсатора  C2 должен удовлетворять условию |ZC(f)|<<R4 для всего 

диапазона частот входного сигнала. Проверьте, выполняется ли это условие для номинала 

конденсатора, изображенного на схеме. 

Наконец, рассчитаем коэффициент усиления по напряжению данной схемы. Усиление 

определяется выражением: , где gm называется крутизной (transconductance) 

характеристики транзистора, определяемой как  . Эта величина равна: , где 

Iк – ток коллектора, который мы уже рассчитали, а VT – т.н. температурный потенциал, 

определяемый как VT = kBT/e, где kB – постоянная Больцмана, Т – абсолютная температура 

(в К), а e – заряд электрона. При комнатной температуре VT ≈ 25mV. Теперь Вы можете 

вычислить крутизну и коэффициент усиления по напряжению. Выразите усиление в 

относительных единицах и в децибелах (дБ). 

Теперь мы можем создать данную схему в OrCAD, промоделировать ее работу и 

проверить наши расчеты. 

 

3. СОЗДАНИЕ И МОДЕЛИРОВАНИЕ СХЕМЫ 

[!] Всегда создавайте отдельную папку для каждого нового проекта в OrCAD, иначе 

постоянно начнут возникать непонятные ошибки, от которых очень трудно 

избавиться. 

По умолчанию папка OrCAD 16.5 в меню Windows 7:  

..\Start Menu\Programs\Cadence\Release 16.5\  

Запустите оттуда ярлык OrCAD Capture и в окне выбора продукта Cadence Product Choices 

выберете  OrCAD PCB Designer Professional w/PSpice. 

Откроется главное окно OrCAD Capture с меню, панелью инструментов и окном лога в 

нижней части экрана. 

 

3.1. Создание проекта. 

1. Создайте новую папку на рабочем диске для хранения всех файлов вашего проекта. 

2. Выберете File > New > Project в главном меню Capture. 

3. В диалоговом окне New Project: 

 Выберете Analog or Mixed A/D. [!] Это важно, т. к. в противном случае вы не сможете 

промоделировать работу схемы. 
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 Нажмите кнопку Browse, выберете ваш рабочий диск и укажите новую папку, которую вы 

создали для вашего проекта, и нажмите OK. Путь к папке с проектом теперь отображается 

в строке Location. 

 Дайте проекту внятное имя. 

 Нажмите OK в диалоговом окне New Project. 

4. В появившемся маленьком диалоговом окне выберете Create a blank project и нажмите OK. 

5. Подождите, пока ваш проект будет создан. В окне Project Manager (верхнем левый угол) 

выберете вкладку File. Здесь показаны файлы, связанные с вашим проектом, а также 

используемые ресурсы, например, файлы библиотеки. В заголовке окна указан полный 

путь к вашему проекту. 

6. Раскройте папку Design Resources, затем ./project-name.dsn, (здесь project-name – название 

вашего проекта), затем папку SCHEMATIC1 и, наконец, дважды щелкните по PAGE1, 

чтобы открыть редактор схемы. В правом нижнем углу редактора в графе Title укажите 

название вашей схемы. 

 

3.2. Создание схемы. Важные моменты. 

 Окно добавления компонент Place Part открывается по клавише [P], на панели 

инструментов справа или через меню Place > Part. 

 Библиотеки компонент должны быть выбраны из папки pspice, иначе у компонент не 

будет PSpice-моделей, и вы не сможете промоделировать их работу. 

 Базовые компоненты, такие как резисторы и конденсаторы находятся в библиотеке analog, 

источники сигналов типа Vsin, Vdc – в библиотеке source. 

 Place > Junction в меню, значок заземления на правой панели инструментов или клавиша 

[G] – добавление 0-го уровня («земля») в схему. 

 

3.3. Моделирование работы схемы. 

Для моделирования работы схемы создаются различные профили моделирования ( 

Simulation Profile).  

Создайте профиль для моделирования амплитудно-частотной характеристики схемы (AC 

Sweep) в диапазоне частот 10 Hz – 100 kHz. Задайте логарифмический диапазон по 

декадам, с 10-ю точками на декаду. Запустите моделирование. Вернитесь в Capture и 

нажмите кнопку [V] на панели инструментов, чтоб включить отображение постоянных 

напряжений в схеме (Bias Voltage Display). Совпадают ли показанные значения 

напряжений с теоретическим расчетами из п.2? Проверьте также токи, протекающие через 

транзистор. 

Далее построим график зависимости коэффициента усиления по напряжению (в дБ) от 

частоты входного сигнала. 

1. Выберете PSpice > Markers > Advanced > dB Magnitude of Voltage из панели меню и 

поместите маркер VDB на выход усилителя. 

2. Теперь можно построить график в децибелах в PSpice.  Для этого необходимо 

использовать входной сигнал с напряжением 1Vac. 

Совпадает ли коэффициент усиления с рассчитанным теоретически значением и остается 

ли он постоянным в звуковом частотном диапазоне? Видно, что коэффициент усиления 

ведет себя не так как ожидалось. Это вызвано тем, что конденсатор C2, включенный 

параллельно эмиттерному резистору R4, слишком мал. Проверим это, промоделировав 

работу схемы с переменным номиналом C2. Для этого понадобится блок 

параметрического моделирования. 

1. Добавьте в схему компонент param из библиотеки special. 

2. Откройте Редактор Свойств (Property Editor) для блока параметров: выберите Edit > 

Properties… на панели меню, в контекстом меню выберете Edit Properties или дважды 

щелкните по блоку. 



3. Выберете Add Row… для создания параметра. Дайте ему имя. Например, Cap2 и 

значение по умолчанию (начальное фиксированное значение). Нажмите OK. 

4. По умолчанию параметр не отображается в схеме, поэтому нужно выбрать 

добавленную строку, нажать кнопку Display, выбрать Name и Value и нажать OK. 

Закройте Редактор Свойств. Теперь вы можете увидеть параметр в блоке. 

5. Измените номинал (value) конденсатора C2  c фиксированного значения на 

параметр. Обратите внимание, что имя параметра, введенное в поле Value, должно быть 

заключено в фигурные скобки {}. 

6. Создайте новый профиль моделирования с амплитудно-частотным 

моделированием и добавьте к нему параметрическое моделирование для Cap2 от 0,1μF – 

1000μF. Используйте логарифмический масштаб с одним значением на декаду. Запустите 

моделирование и постройте семейство графиков в децибелах, как это было описано выше. 

Улучшает ли увеличение номинала C2  АЧХ коэффициента усиления? Какое значение 

является оптимальным?  

 

4. ПОДГОТОВКА К СОЗДАНИЮ ПЕЧАТНОЙ ПЛАТЫ 

4.1. Важные моменты при работе с корпусами (footprint) компонентов: 

 «Виртуальные компоненты» (типа источников питания и генераторов сигналов) в 

схеме должны быть заменены на реальные компоненты. Реальная схема должна содержать 

разъемы для входных и выходных сигналов, а также разъем подачи питания. Разъемы 

добавляются из библиотеки Connector, расположенной в 

…\Cadence\SPB_16.5\tools\capture\library 

 

 
 Электролитический конденсатор C_elect из библиотеки ANALOG несовместим с 

корпусом. Выводы корпуса пронумерованы как 1, 2, а выводы символа конденсатора 

названы p, n. Это значит, что OrCAD не сможет подключить корпус к конденсатору. Для 

решения данной проблемы необходимо изменить нумерацию выводов конденсатора.

 



1. Выберете электролитический конденсатор и в меню выберете Edit > Part. Откроется 

окно с увеличенным изображением конденсатора. 

2. Положительный вывод (слева)  отмечен кружком. Выделите его и выберете  Edit > 

Properties. Откроется диалоговое окно Pin Properties (см. рис.) 

3. Введите 1 в поле  Number, не трогайте поле Name. 

4. Отрицательный вывод (справа) конденсатора отмечен красным. Измените значение 

его свойства Number на 2. 

5. Выберете File > Close.  Вы можете обновить только этот компонент, выбрав Update 

Current, или обновить все компоненты данного типа в схеме (если у вас в схеме несколько 

электролитических конденсаторов), выбрав  Update All. 

 Если какие-то выводы компонента (например, микросхемы) в схеме не 

используются и остаются неподключенными, то чтобы не возникало ошибок в PCB, 

выберете Place > No Connect и щелкните на неподключенный вывод – на конце вывода 

появиться крестик-«заглушка». PCB Editor требует, чтобы выводы всех компонентов в 

схеме были подключены либо явно отмечены как неподключенные. 

 Некоторые электронные компоненты выпускаются в корпусах с числом выводов 

бОльшим, чем число выводов самого компонента.  Например, операционный усилитель 

(ОУ) с 7-ю выводами
1
 выпускается в корпусах DIP8 и SOIC8, при этом один вывод просто 

не используется. Если в таком случае просто подключить корпус к ОУ – получим ошибку 

о несовпадении числа выводов элемента и корпуса. Для решения данной проблемы 

необходимо явно задать с неподключенный вывод в компоненте (рассмотрим на примере 

ОУ): 

1. Выберете ОУ, затем Edit > Part – откроется окно Part Editor. 

2. Выберете Options > Part Properties – откроется окно пользовательских свойств User 

Properties. 

3. Нажмите кнопку New…, дайте новому свойству имя NC ( сокр. от No Connect – 

неподключено) и значение 8 (8 – номер неиспользуемого вывода на корпусе). Если 

неиспользуемых выводов больше одного – перечислите их все, разделяя запятыми, 

например,  8, 9, 10. 

4. Закройте Part Editor и обновите компоненты   Update All в схеме. 

4.2.  Добавление корпусов к компонентам схемы. 

1. Выделите курсором мыши всю схему, не захватывая при этом рамку с названием схемы. 

2. Выберете в меню Edit > Properties – откроется таблица свойств (типа MS Excel) 

3. Введите типы корпусов элементов в поля PCB Footprint. Библиотеки корпусов 

расположены в  \Cadence\SPB_16.5\share\pcb\pcb_lib\symbols.  

4.3. DRC 

Следующий шаг – проверка соблюдения проектных норм созданной схемы – Design rules 

check –  DRC. 

1. Выберете окно  Project Manager и выделите файл вашей схемы (с расширением 

.dsn) 

2. Выберете в меню Tools > Design Rules Check 

3. В Design Rules отметьте флажками Run Electrical Rules (может быть уже отмечен) и 

Run Physical Rules. Поставьте флажок. View Output. 

4. Нажмите ОК. Может появиться сообщение «One or more errors or warnings were 

encountered. Do you wish to view the messages in the session log?» Нажмите ОК и 

просмотрите сообщения об ошибках и предупреждениях в открывшемся текстовом файле. 

Отсутствие ошибок говорит о соответствии схемы проектным нормам. 

5. Вернитесь в редактор схемы, исправьте ошибки, отмеченные зелеными кружками, 

и повторите проверку DRC. 

6. Когда все ошибки будут исправлены окне DRC выберете Action > Delete existing 

DRC markers, чтобы убрать зленые кружки со схемы. Сами по себе они не исчезают. 

                                                           
1
 Прямой вход, инверсный вход, выход, 2 входа +- питание, 2 входа подстройки смещения нуля. 



 

4.4. Создание пустой платы в PCB Editor 

Простейший способ создания PCB – настроить пустую плату, а затем добавить на нее 

компоненты и соединения созданной вами схемы. , 

Сначала создайте директорию allegro внутри директории вашего текущего проекта. PCB 

Editor сохраняет свои файлы в директории с таким именем. Затем выберете   

Start > Programs > Cadence > Release 16.5> OrCAD PCB Editor 

В открывшемся PCB Editor выберете File > New… в главном меню. В первом диалоговом 

окне в списке Drawing Type выберете Board (wizard). Нажмите Browse…, зайдите в 

созданную вами новую директорию allegro и задайте имя вашей платы, например так: 

bare.brd. Нажмите Open(Открыть), затем OK, чтобы перейти к диалоговому окну Board 

Wizard. Оно включает в себя несколько страниц, где задаются параметры вашего PCB. 

Некоторые из них просты и понятны, например размеры платы, другие устанавливают 

нормы проекта (design rules) – такие как ширины дорожек и зазоров между ними и т. п. 

1.Первая страница – ознакомительная. Здесь представлена общая схема настройки 

пустой PCB. Нажмите OK. 

2.Далее идет запрос платы-шаблона, откуда могут быть импортированы параметры 

настройки. Обычно платы-шаблона под рукой нет, поэтому выберете No (установка по 

умолчанию) и нажмите Next>. 

3.Далее идет запрос tech file. Это сокращенное обозначение  technology file, который 

содержит нормы проекта – число слоев на плате, ширину дорожек и зазоров и т. д. Т. к. 

такого файла у нас нет – выбираем No и жмем Next>.  

4.Далее идет запрос на импорт корпуса платы (board symbol). Т. к. корпус платы еще 

не нарисован, выберете снова No и нажмите Next>. 

5.Далее идут страницы настройки параметров платы. Единицы измерения (Units) 

должны быть заданы в Mils (1 mm ≈ 40 Mils ).  Оставьте размер листа (Size) как А. Это 

американский стандарт, который нельзя заменить на стандартный размер листа А4, если в 

качестве единиц измерения выбраны Mils. 

6.Установите масштабную сетку (grid spacing) в 100 mils. Параметр  Etch layer count 

это число медных слоев на плате – число слоев с дорожками сигналов и дорожками 

питания. Большинство плат изготавливаются двуслойными, поэтому оставляем 2. 

Параметр  artwork films оставляем по умолчанию. Next>. 

7.Оставьте параметры слоев Top и Bottom как Routing Layer. Next>. 

8.На следующей странице указываются минимальные расстояния между дорожками 

(Line) и контактными площадками (Pad) на плате. Если нет жестких требований можно 

ввести 25 Mils. Для задания параметров межслойных переходных отверстий (Default via 

padstack) нажмите […] и выберете Via. OK, Next>. 

9.Далее идет выбор формы платы. Выберете Rectangular board. Next>. 

10.Следующая страница задает размеры платы и допустимые границы размещения 

дорожек и компонент.  Зададим ширину 3000 и высоту 2000 mils – получаем плату с 

соотношением сторон 3:2. Зададим Route keepin distance 100. Keepin означает, что объекты 

должны удерживаться в пределах специальных границ. В данном случае это означает, что 

дорожки не могут располагаться ближе, чем 100 mils от края платы. Зададим Package 

keepin distance в 250 mils. Тем самым компоненты на плате могут быть расположены не 

ближе чем 250 mils от края платы. Зазор между этими двумя зонами позволяет провести 

дорожки со всех сторон каждого компонента, что весьма полезно для сложных плат. 

11.Нажмите Finish – создание пустой платы завершено. 



 

Теперь в главном окне PCB Editor отображается созданная плата-заготовка. Видимые 

прямоугольники обозначают границы платы, зону размещения дорожек и зону 

размещения компонент. Выберете File > Save и закройте PCB Editor. 

Следующий шаг – вернуться в Capture и отправить созданную схему в PCB Editor, чтобы 

она могла быть добавлена на пустую плату-заготовку. 

 

4.5. Создаие Netlist 

Информация о вашей схеме пересылается из Capture в PCB Editor в списке соединений – 

netlist, который состоит из трех файлов и содержит описание схемы и ее компонент. 

1. Выделите вашу схему – файл с расширением .dsn в окне Project Manager в Capture. 



2. Выберете Tools > Create Netlist… на панели меню, это откроет диалоговое окно, 

показанное на рисунке. Выберете в нем вкладку PCB Editor. 

 
3. Проверьте, что в поле PCB Footprint введено PCB Footprint. 

4. Проверьте, что установлен флажок  Create PCB Editor Netlist. 

5. В поле  Netlist Files Directory должно быть введено allegro. Установите флажок 

Create or Update PCB Editor Board (Netrev). 

6.  Для Input Board File выберете пустую плату, которую вы создали в п.4.4.  нажмите 

на кнопку […] для открытия диалогового окна выбора файла. 

7. Запись в Output Board File формируется автоматически, редактировать ее не нужно. 

Здесь используется новая папка allegro. 

8. В рамке Board Launching Option выберете, версию PCB Editor. В которой вы будете 

разводить плату. 

9. Нажмите ОК, чтобы закрыть диалоговое окно и запустить создание netlist. 

Вы получите сообщение, что ваша схема будет сохранена в Capture, затем в Progress Box 

будут показаны стадии процесса: Netlisting the design, затем Updating OrCAD PCB Editor 

Board. После этого будет запущен PCB Editor c вашей новой платой. 

 В окне Warning может появиться сообщение  Netrev succeeded with warnings. В этом 

случае проверьте Session Log. Сообщения о RVMAX b CMAX можно проигнорировать, 

это максимальные напряжения для резисторов и конденсаторов и они не важны для 

данной схемы. Обратите внимание на все остальное предупреждения и устраните их. 

 OrCAD PCB Editor может выдать сообщение Database was last saved by a higher tier 

tool, которое вы можете проигнорировать. 

 



Если все сделано правильно, то в открывшемся PCB Editor вы увидите пустую плату, 

которую создали в п.4.4. Сами компоненты схемы на данном этапе еще невидимы. 

 

5 OrCAD PCB Editor 

OrCAD PCB Editor является базовой версией редактора печатных плат Allegro от Cadence. 

Несмотря на то, что это базовая версия продукта, это гораздо более мощный инструмент, 

чем необходимо для простых конструкций, которые мы будем рассматривать в этом 

курсе. Его интерфейс может показаться непривычным, потому что приложение было 

первоначально разработано для UNIX и было портировано на Windows, с минимальными 

изменениями. Некоторые отличительные особенности очевидны почти сразу. 

• Окно, в котором отображается ваша плата, не имеет полос прокрутки. 

• Один дизайн всегда открыт, вы не можете открыть больше, чем один, ни закрыть 

текущий проект не открывая новый или не выходя из приложения. 

• Там нет "нуль" инструмента, как указатель, который есть в приложениях для рисования, 

когда не выбран другой инструмент. 

Важным аспектом интерфейса является то, что инструменты могут быть использованы 

двумя способами. 

• Сначала выберите команду, либо из главного меню или нажав на кнопку, затем на 

элемент конструкции, над которым инструмент должен работать. 

• Выберите объект, а затем команду из контекстного меню, щелкнув правой кнопкой 

мыши. 

Я буду использовать оба метода в учебнике, выбирая в зависимости от того, какой 

окажется кажется наиболее подходящим. Однако путаница может возникнуть, когда вы 

переходите от одного метода к другому. Поэтому хорошая способ при переключении 

отключить любой активный инструмент (щелкните правой кнопкой мыши и выберите 

Done, если оно предлагается) и очистить любое выделение (щелкните левой кнопкой 

мыши за пределами борту или правой кнопкой мыши и выберите Selection Set >Clear All 

Sections) 

5.1 Экран 

Редактору печатных плат необходим большой экран - старенький ноутбук, который я 

использовал для иллюстрации этих инструкций не является достаточно большим, чтобы 

показать все панели инструментов! Основные элементы применения приведены на 

рисунке 8 на следующей странице. 

• Окно дизайна, занимает большую часть экрана, где вы разводите плату. Оно всегда 

показывает плату сверху; нижний слой рассматривается через плату, как будто она 

прозрачная

. 

• Строка 

меню 

наверху, 

как 

обычно. 

 

 

Рисунок 8. 
Скриншот 

из OrCAD 

PCB Editor 

с пустой 

платы; 

черный 

фон был 

изменен на 



белый для более четкой печати. Прямоугольники показывают контур платы (внешние). 

Панели «Find» и «Options» открытs справа. 

• Панели инструментов в два ряда под строкой меню и еще колонка с левой стороны. 

Их расположение зависит от размера экрана. Наведите указатель мыши на кнопку, чтобы 

показать функцию. 

• Панели управления с вкладками на правой стороне. Каждая панель выскакивает при 

перемещении указателя на ее вкладку. Нажмите на булавку, чтобы зафиксировать панель 

открытой. 

- Find выбирает тип объекта, который будет выделен при перемещении мыши вокруг 

рисунка. 

- Options меняются в зависимости от текущего режима и команды, выбирается активный 

класс и подкласс, когда редактор печатной платы находится в режиме ожидания, то 

предлагает подходящие варианты, когда выбрана команда. 

- Visibility скрывает слои травления во время трассировки платы. 

Я настоятельно рекомендую, чтобы вы держали панели Find и Options открытым, как на 

рисунке 

8; Visibility менее полезен для плат только с одним или двумя слоями травления. 

• Консольное окно в нижней левой части экрана. В нем выводится log файл ваших 

действий и нужно, когда Allegro ожидает ввода. Оно также отображает вывод команд, 

таких как Design Rules Check. 

• Окно Worldview в правом нижнем углу показывает, как соотношение между контура 

платы, так и вид в главном окне дизайна. Это полезно для перемещения окна конструкции 

по плате, как мы скоро увидим. 

• Строка состояния в нижней части экрана. Он показывает координаты указателя 

(перекрестье). Р (Pick) кнопка полезна для набора текста координаты вместо щелчка 

мышью, если Ваша рука находится в неустойчивом положении. 

С краю справа находится цветной блок DRC, который отвечает за проверку правил 

проектирования. Он может быть желтым, потому что проверка не актуальна. Обычно он 

должен быть зеленым, показывая, что автоматическая проверка включена и что никаких 

ошибок не обнаружено. 

Много жаргона связано с Allegro. Это часто относится к вашему дизайну в качестве базы 

данных, так как он ей и является с точки зрения компьютера. Различные элементы 

конструкции подразделяются на классы и подклассы, которые я пишу как класс/подкласс 

в инструкции. Вот некоторые общие примеры. 

• Класс Etch (Травление) включает области меди, которые работают как подложки для 

компонентов и дорожки, которые несут сигналы между ними. Наши конструкции имеют 

два подкласса травления, Top и Bottom. Они окрашены в зеленый и желтый 

соответственно. 

• Класс Board Geometry включает Outline, который мы уже видели. Подклассы 

Silkscreen_Bottom и Silkscreen_Top используются для текста, чтобы комментировать 

плату. 

• Мы также видели класс Package Keepin, используемый для предотвращения размещения 

элементов слишком близко к краю платы. Он не имеет подклассов. 

Активный класс и подкласс можно выбрать на панели управления Options, но редактор, 

как правило, выбирает их автоматически, когда вы активируете инструмент. 

5.2 Перемещение по проекту  

Есть два метода, которые могут быть использованы для перемещения в желаемую область 

проекта. 

• С помощью клавиш со стрелками на клавиатуре. 

• Удерживая среднюю кнопку мыши и перетаскивая. Запутывающей особенностью 

является то, что перемещается окно над дизайном. Это означает, что конструкция 

движется в противоположном направлении.  



Но у меня есть только мышь с двумя кнопками! Многие мыши с двумя кнопками имеют 

колесико прокрутки, которое выступает в качестве средней кнопки при нажатии. 

Кроме того, может возникнуть необходимость сосредоточиться на мелких деталях или 

уменьшить масштаб, чтобы рассмотреть полный макет. Опять существует два метода. 

 

Рисунок 9. Диалоговое окно Placement, показывающее компоненты для усилителя с 

одним-транзистором. Транзистор Q1 готов для размещения на плате. 

• Используйте команды в меню View или соответствующие кнопки и ярлыки. Zoom Fit 

отображает макет полностью в окне, что часто бывает полезно. 

• Колесо прокрутки мыши увеличивает и уменьшает масштаб, фиксируясь на текущей 

позиции указателя. 

Окно WorldView также может быть использовано для увеличения и панорамирования. 

Если вы растяните в нем прямоугольник, то увидите его содержимое в главном окне. 

Я мог бы написать намного больше об интерфейсе, но более интересно размещать 

компоненты и разводить печатную плату. 

5.3 Размещение и выравнивание компонентов 

Выберите Place> Manually. . . в строке меню, чтобы начать размещение компонентов. 

Появится диалоговое окно Placement, показанное на рисунке 9. Вкладка Placement List 

должна быть активной и список должен отображать компоненты по RefDes с 

компонентами в вашем проекте, перечисленных ниже. 

Разместить компоненты для этой простой конструкции очень просто. См. рисунок 10 на 

следующей странице для руководства. 

1. Начните с транзистора. Установите флажок рядом с Q1 в диалоге Placement. Его контур 

появится в поле Quickview Box. 

2. Переместите курсор из Placement на ваш проект. Контур транзистора прикреплен к 

курсору. Щелкните левой кнопкой мыши, чтобы поместить его в центре на доске. Контур 

будет заполнен и небольшой символ «P» для «placed» появится в поле Placement рядом с 

RefDes. 



 
Рисунок 10. Скриншот платы простого, одно-транзисторного усилителя после 

размещения всех компонентов. Голубые линии показывают связи между компоненты. 

3. Далее поместите разъемы для входа и выхода. Установите флажки для J1 и J2. Наведите 

указатель мыши на схему и заголовок two-pin для J1 появится при наведении курсора. 

Щелкните где-нибудь слева, чтобы поместить его. Не беспокойтесь о его ориентации на 

данный момент. 

4. Контур J2 теперь автоматически появляется при наведении курсора, поместите его на 

правой стороне. 

5. Затем разместите четыре резистора. Поместите их в тех же положениях относительно 

транзистора, так как изображено на схематическом рисунке. Так будет проще соединить 

схему. Обратитесь к вашему схематическому чертежу для определения каждого 

резистора. Размещайте все компоненты внутри внутреннего фиолетового прямоугольника, 

который показывает Package Keepin. Он становится зеленым, если вы попытаетесь 

разместить любую часть компонента за ее пределами. 

6. Поместите два конденсатора таким же образом. На этом размещение закончено, можете 

закрыть диалоговое окно. 

Компоненты соединены множеством голубых линий, которые называются ratsnest, чтобы 

показать их логические соединения. Эти линии будут превращены в медные дорожки при 

трассировке платы. Линии ratsnest просто используют кратчайший путь между 

компонентами и, следовательно, пересекаются друг с другом. Реальные дорожки не могут 

этого сделать. Поэтому очень важно, настроить ориентацию и положение размещенных 

компонентов чтобы сократить количество пересечений ratsnest и упростить трассировку. 

Прежде чем сделать это, попробуйте перемещая мышь по окну конструктора без щелчков. 

Элементы выделяются и информационная надпись появляется как только мышь проходит 

над ними; нет необходимости нажимать на объект, чтобы выделить его как во многих 

графических программах. Если навести курсор на контур транзистора, например, будет 

показано сообщение " Q1 ". Мышь может выделить контур компонента, контакты, текст 

или линии ratsnest. Как мы можем быть уверены, что мы перемещаем компонент целиком, 

а не только его часть? Перемещение только контакта будет очень плохой идеей, например. 



Рисунок 11. Панель управления Find настроена так, что могут быть выбраны только 

символы. 

Это тот случай, когда панель Find может быть полезна. Откройте её, перемещая курсор к 

её вкладке, если она уже не открыта, нажмите кнопку ALL OFF, затем выберите Symbols 

как на рисунке 11. Только символы компонентов полностью выделены под мышкой. 

Отдельные контакты больше не выделяются. Так гораздо легче перемещать и вращать 

компоненты. 

• Самый простой способ перемещения компонента – это щелкнуть левой кнопкой мыши 

по нему и перетащить, удерживая кнопку мыши . 

• По-другому, переместите указатель мыши на компонент, щелкните правой кнопкой 

мыши и выберите Move из контекстного меню. Щелкните левой кнопкой мыши на 

нужном месте. 

• Чтобы повернуть выбранный компонент, щелкните правой кнопкой мыши, выберите 

Spin и переместите мышь, чтобы получить нужную ориентацию. 

• Оба эти действия также можно выбрать в меню Edit и на панели инструментов кнопкой 

Move. 

• Не используйте команду Mirror, который отличается от команд в Capture. Здесь она 

перемещает компонент из верхней части к нижней части печатной платы. 

Переместите и поверните компоненты для упрощения ratsnest. Эта схема простая, потому 

что нет пересечений, если вы будете следовать схематическому рисунку, что делает 

трассировку очень простой. Когда вы разместили и расположены все компоненты, 

обновите правила проектирования и проверьте на ошибки. Для этого выберите 

Tools>Update DRC в строке меню. DRC блок вблизи нижней правой части окна становится 

зеленым, и командное окно показывает No DRC Errors detected, если все правильно 

сделано. Если вы разместили компонент вне Keepin, например, сообщение будет DRC 



done; 1 errors detected. Ошибка показывается маркером маленькой красной 'бабочкой' на 

схеме. Переместите компонент внутрь Keepin и маркер исчезнет.  

Рисунок 12. Скриншот разведенной платы простого одно-транзисторного усилителя. 

Дорожки выделены желтым, это показывает, что они находятся на нижней части платы. 

Изображение на вашем экране может не совпадать с рисунком, потому что зависит от 

того, какие классы активны в данный момент. 

Сохраните ваш проект с новым именем для заполненной платы. Необычно то, что Allegro 

cпросит вас хотите ли вы перезаписать существующий файл. Вы можете сохранить разные 

версии под разными именами, в случае если вам нужно вернуться назад и что-то 

переделать. Allegro не сохраняет резервные копии автоматически. 

5.4 Трассировка платы 

Электрические соединения, изображенные ratsnest теперь должны быть заменены 

медными дорожками на печатной плате. Эта процедура называется трассировкой платы. 

Слои меди называются Etch (травление) в Allegro из-за обычного производственного 

процесса. Дорожки должны быть сделаны на нижней части платы с компонентами на 

верхней (где они идут по умолчанию). Провода от компонентов проходят через отверстия 

в посадочных местах и припаяны к дорожкам на нижней части платы. 

Жаргон: Cline – сокращение от «connecting line», сегмент медной дорожки. Простая линия 

может показать край платы или контура компонента и не является проводником. 

Старайтесь проводить дорожки настолько простым образом, как это возможно - 

представьте, что вы паяете плату самостоятельно. Не усложняйте жизнь дорожками 

излишне близкими к посадочным местам, например. Вы должны стремиться к тому виду 

макета, который показан на рисунке 12, но нет никакой необходимости следовать ему 

точно. Нарисуйте дорожки следующим образом. Прежде чем начать, убедитесь, что ни 

один объект не выбран (левой кнопкой мыши вне доски или щелкните правой кнопкой 

мыши и выберите Selection Set>Clear All Selections), и что ни один инструмент не активен 

(щелкните правой кнопкой мыши и выберите Done, если оно предлагается). Закрепите 

панели Find и Options открытыми, это поможет легче управлять инструментами. 

1. Выберите Route>Connect в строке меню.  

Рисунок 13. (а) Options и (б) Find панели управления команды Add Connect , и (с) Options 

для Slide. 

2 . Панель Options меняется, для отражения текущей деятельности и в настоящее время 

показывает слои, доступные для трассировки. Мы хотим, чтобы все дорожки проходили 

на нижней части платы, изменим Act(активный) слой на нижний, который окрашен 

желтым цветом. Вы также можете изменить Alt (альтернативный) слой на верхний, 

(a
) 

(b
) 

(c
) 



который окрашен в зеленый цвет, но нам нужен только один слой для этой схемы. Line 

lock должна быть 45 (в градусах), которая определяет допустимое изменение направления 

дорожки. Смотрите рисунок 13 (а). Панель управления Find (рис. 13 (б)) автоматически 

настраивается, для выбора соответствующих объектов для трассировки: контакты, 

переходные отверстия, контуры, Cline сегменты и ratsnests. (Формы, как правило, участки 

травления, и именно поэтому они являются активными) 

3. Щелкните левой кнопкой мыши на контакт, чтобы начать трассировку сегмента – части 

дорожки, которая идет от одного контакта на другой. Сегмент ratsnest выделяется, 

показывая, что он доступен для трассировки. 

4. Переместите мышь к контакту на другом конце выделенного ratsnest. Толстая желтая 

линия рисуется, показывая дорожку меди и заменяет линию ratsnest. 

5. Нажмите на промежуточных точках, чтобы исправить углы. Они автоматически 

преобразуются на 45 °, что хорошо. Не хорошо рисовать углы 90 °, потому что они 

склонны к повреждению в процессе травления. 

6. Нажмите на конечном контакте для завершения дорожки. 

7. Трассируйте все сегменты ratsnest . Щелкните правой кнопкой мыши и выберите Done, 

когда закончите. 

Запустите проверку для обнаружения проблем с трассировкой. Для получения 

дополнительной информации, выберите Display > Status... в строке меню. В разделе, 

Symbols и Nets должно быть показано что все размещено и трассировано, в то время как 

ошибки DRC должна быть показана как Up to date без ошибок. Сохраните вашу плату. 

Есть несколько способов отмены действия. 

• Щелкните правой кнопкой мыши и выберите Oops. Это отменяет последние частичные 

действия, например, рисование последнего сегмента дорожки. 

• Щелкните правой кнопкой мыши и выберите Cancel, это отменит последнее законченное 

действие. 

• Выберите Edit>Undo чтобы отменить более ранние действия. 

• Если вы сделали полный бардак, перейдите в меню File>Recent Designs и перезагрузите 

ваш преокт без сохранения изменений. Это отменит все изменения с момента последнего 

сохранения файла, которое, надеюсь, было не так давно... 

Мои дорожки выглядят не очень хорошо: Как я могу их улучшить? 

Редактор печатных плат предлагает множество способов корректировки дорожек. Сначала 

убедитесь, что вы не все еще используя инструмент Connect, щелкнув правой кнопкой 

мыши и выбрав Done, если этот пункт появляется в контекстном меню. Небольшие 

корректировки дорожек могут быть сделаны из меню Route>Slide Tool, которое загружает 

панель Options, в виде показанном на рисунке 13 (с) на предыдущей странице. Я 

предлагаю вам изменить Bubble от значения по умолчанию Shove preferred на Hug only. 

Нажмите и отпустите кнопку мыши на сегменте, чтобы выбрать его, подвиньте и нажмите 

еще раз, когда вы будете довольны результатом. Другие полезные инструменты в меню 

Edit> Vertex и Edit> Delete Vertex. Для больших изменений, вы, возможно, пожелаете 

удалить часть дорожки или дорожку полностью и перерисовать её. Действуйте 

следующим образом. 

• Наведите указатель мыши на сегмент, который нужно выделить. Если этого не 

произойдет, откройте 

Панель управления Find и выберите All On. 

• Вы можете удалить травление на трех слоях с помощью контекстного меню: 

- Delete удаляет сегмент - одну прямую линию дорожки между углами или контактами. 

- Connect Line>Delete удаляет полностью дорожку (Cline) между двумя ближайшими 

контактами или переходами. 

- Net> Ripup etch отменяет трассировку цепи полностью. 

• Use Route>Connect перерисовывает дорожку. 

Это хорошо иллюстрирует иерархию выбора: просто сегмента, полную линейку или всей 

цепи. 



Aaa! - Я только что обнаружили ошибку в схеме 

Если вы заметили ошибку в схеме, а не на макете, следуйте инструкциям в разделе А на 

стр. 47. Вы можете скорректировать схему в Capture и отправить новый список 

соединений в PCB Editor, который делает минимальное количество изменений в вашей 

плате. Не обязательно переделывать весь макет. Это является одним из преимуществ 

системы автоматизированного проектирования. 

5.5 Добавление текста 

Следующая добавить текст на плату, чтобы сделать ее проще в изготовлении и 

использовании. В частности, у всех разъемов должны быть указаны функции выводов как 

на схеме. Ваше имя может быть тоже полезно. Нет необходимости добавлять описание 

каждого компонента, потому что RefDes и значение показываются автоматически. Текст и 

контуры компонентов печатаются на промышленных платах с помощью чернил или 

краски в виде слоя под названием Silkscreen. Мы не можем делать шелкографию в 

университете, поэтому текст должен быть размещен на медных слоях. 

1 . Начните со своего имени на плате. Выберите Add > Text from menu. 

2 . Используйте панель управления Options для выбора места для текста.  

• Разместите какой-нибудь текст, например ваше имя на нижнем слое меди, потому что 

это часть каждой платы. Активным классом должен быть Etch, а подклассом должен быть 

bottom. 

• Текст на нижней части платы должен быть отражен, чтобы он правильно читался, для 

этого установите флажок Mirror. 

• Текстовый блок довольно запутанный способ задания размера текста. Большее число для 

блока делает текст больше. Значение около 4 в самый раз для вашего имени. 

3 . Нажмите на макете там, где вы хотели бы написать текст и пишите. Нажмите Return 

(Enter), чтобы перейти на новую строку. Щелкните мышкой, чтобы создать новый блок 

текста в другом месте или правой кнопкой мыши и выберите Done, когда закончите. 

4 . Теперь добавим текст на верхней части платы, чтобы определить разъемы. Снова 

выберите Add >Text, но на этот раз установитt активный класс и подкласс Etch/Top. 

Выключите отражение и уменьшите размер до 2. Добавьте текст для входа и земли рядом 

с входным разъемом и питанием, выходом и землей выходного разъема. Не размещайте 

текст на посадочных площадках: он печатается на меди и может привести к короткому 

замыканию. 

Поздравляем! - Вы сделали свою первую печатную плату. Не забудьте сохранить его. 

5.6 Печать проекта 

Самый простой способ печати проекта является печать на плоттере. Выберите File> 

Plot setup... из меню и выберите следующие настройки. 

• Обычно участка масштабирования должно быть сделано так, что размер отпечатка 

совпадает с печатной платой. Эта плата настолько простая, что лучше увеличить, так что 

введите значение 2. 

• Измените вес линии по умолчанию до 10, в противном случае контуры будут тонкие и 

нечеткие. 

• Выберите Auto center при ориентации рисунка. 

• Установите цветной метод печати и закройте диалоговое окно. 

Откройте панель управления Options и установите активный класс Etch/Bottom. Это 

настроит наиболее важные опции. Теперь печать макета File>Plot... 

• Нажмите Setup... Убедитесь, что размер бумаги выбран правильно и находится в 

альбомной ориентации. Подтвердите также, что выбран правильный (цвет) принтер.  

• Нажмите кнопку OK, чтобы напечатать ваш макет.  

Изображение должно напоминать рисунок 12 на стр. 23, за исключением того, что цвета 

на изделии непрозрачны.  

Эта распечатка не подойдет для изготовления печатной платы. В следующем проекте я 

покажу вам, как получить распечатки, которые можно использовать, чтобы сделать вашу 



печатную плату в университете.  

6. Инструментальный усилитель – односторонняя плата 

Второй проект - это еще одна классическая схема, показанная на рисунке 14 на 

следующей странице. Это инструментальный усилитель на основе трех операционных 

усилителей. Вы будете изучать его работу в Аналоговой электронике 2. Его основные 

характеристики следующие. 

• Оба входа имеют высокое входное сопротивление, потому что каждый из них 

подключен непосредственно к неинвертирующему входу операционного усилителя. 

• Третий ОУ действует как вычитающий, для того чтобы определить разность между его 

входами (он может обеспечить усиление, но я предпочел этого не делать). 

• Усиление для дифференциальных сигналов (разница V+ - V-) может быть 

скорректирована одним резистором R2.  

• Усиление синфазных сигналов (где V + = V-) очень низокое. 

Схема используется для усиления небольшой разницы в напряжении между двумя 

входами, в то же время, уменьшая большое фоновое напряжение или шум, которые 

влияют на оба входа в равной степени. Это часто необходимо в схемах с датчиками. На 

практике маловероятно, что схема будет построена с использованием трех отдельных 

корпусов с одним ОУ как в этом проекте. Готовые инструментальные усилители доступны 

в 8-контактных корпусах. Даже если они непригодны, четверной пакет, который содержит 

четыре операционных усилителей можно использовать, хотя они не имеют контактов для 

устранения напряжение смещения. Мы не будем моделировать эту схему, просто сделаем 

плату. LF411 является широко используемым ОУ. 

Рисунок 14. Инструментальный усилитель на трех ОУ. 

6.1 Schematic capture 

Создайте новый каталог для этого проекта, как всегда, и создайте новый проект в Capture. 

Разместите компоненты на схеме, но подключать их пока не нужно. Единственный 

незнакомый компонент это потенциометр, который называется pot – найдите его. Шины 

питания, как правило, скрыты, чтобы упростить схематические рисунки. Здесь выводы 

питания ОУ подключены к обозначенным символам питания. Capture считает все символы 

питания с одним и тем же именем соединенными вместе. Символы «земли» работают 

таким же образом. (Часто сами выводы питания скрыты, как мы увидим в окончательном 

проекте.) Подключите блок питания следующим образом. 

1. Выберите Place>Power... или нажмите кнопку c символ питания на панели 

инструментов и выберите VCC_CIRCLE из библиотеки CAPSYM. Используйте тот же 

символ для обоих источников +15 В и-15V. Разместите его возле каждого вывода питания, 

при необходимости отразите вертикально и подключите его к контакту коротким 

проводом. 



2. Дважды щелкните имя каждого символа питания и изменить название на VCC для 

положительного и VEE для отрицательного питания соответственно. Это стандартные 

обозначения (но есть и многие другие). Проверьте внимательно ориентацию ОУ! 

Некоторые отражены вертикально, чтобы сделать схему понятнее, это как правило 

переворачивает контакты питания. 

3. Таким же образом, выберите Place>Ground... или нажмите кнопку заземления. 

Используйте GND из CAPSYM для символов заземления. Эти символы должны иметь 

одно то же имя на протяжении всего процесса рисования, или они не будут связаны. 

Соедините компоненты и добавьте текст для идентификации контактов двух разъемов. 

У двух ОУ есть неподключенные контакты. Это сделано специально, потому что они 

нужны для настройки смещения и ее надо сделать только на одном ОУ. PCB Editor 

должен об этом знать, в противном случае он предположит, что вы случайно пропустили 

соединения и выдаст ошибку. Покажите, что контакты намеренно не подключены, выбрав 

Place> No Connect в строке меню или нажав на кнопку, а затем нажав на контакты. 

Появляется небольшой крестик как на рисунке 14. PCB Editor требует, что каждый 

контакт должен быть подключен или явно помечен как не подключенный. Затем выберите 

макеты. Вы должны определить, какие использовать для себя. Реальные компоненты 

доступны в лаборатории, и вы должны сопоставить их с каталогом нашей местной 

библиотеки, которая показана в конце данной брошюры. Лучше всего установить ИС в 

разъемы для студенческих проектов, а не паять их непосредственно к печатной плате, так 

что выбирайте из GU-DIPSOCK макетов для ОУ. 

Замечание. Несовместимостм между Capture и PCB Editor должны снова быть 

исправлены обновлением списка соединений . Во-первых, контакты электролитических 

конденсаторов ошибочно пронумерованы. Повторите действия в разделе 4.1 на стр. 9, 

чтобы исправить это. 

Замечание. Новая проблема в том, что только 7 контактов показаны на электрических 

символах для ОУ но корпус имеет 8 контактов. Вы могли бы подумать, что программное 

обеспечение могло предположить, что неопределенные выводы не подключены, но это не 

так: это должно быть указано .  

1 . Выберите один из операционных усилителей и выберите Edit> Part , откроется Part 

Editor.  

2 . Выберите Options>Part Properties..., появится список User Properties.  

3 . Нажмите New… Задайте имя новому свойству NC, что значит No Connect, и значение 

8, которое указывает номер, не подключенного контакта. (Используйте список 

разделенный запятыми, например, 7,8, если много контактов не подключено.)  

4 . Нажмите OK , чтобы закрыть диалоговые окна и закройте Part Editor. Выберите Update 

All, чтобы изменения применились ко всем LF411 в вашем проекте. Свойство NC было 

сделано видимым на схеме на рисунке 14 на предыдущей странице, которое, показывает 

NC = 8 , но вам это не нужно. Запустите Design Rules Check и исправьте ошибки. 

Распечатайте схему, когда она будет завершена, и прошла DRC. 

 

6.2 Создание печатной платы и размещение компонентов 

Не забудьте создать каталог Allegro. Настройте плату, как и раньше ( п. 4.4 на стр. 13), но 

сделайте ее 3.500 × 2.500, это даст вам достаточно места для большего числа компонентов. 

Сохраните плату и выйдите из PCB Editor. Вернитесь в Capture, создайте список 

соединений и отправьте проект в PCB Editor, как и ранее. Проверьте Session Log: 

Игнорируйте любые предупреждения о RVMAX но проверяйте любые другие. Мы будем 

размещать компоненты при помощи другого метода на этот раз. Выберите Place>Quick-

place... в строке меню. Значения по умолчанию должны подойти (Поместите все 

компоненты вокруг Keepin, на Top) . Выберите Place затем ОК. Ваши компоненты будут 

расположены в верхнем слое платы, готовые для перемещения в нужное место. 

Разместите компоненты на плате, выровняйте их в соответствии схематическому рисунку 

и настройте их, чтобы сделать ratsnest простым с как можно меньшим количеством 



переходов (невозможно, устранить все пересечения). Этот шаг является действительно 

важным. Легко проводить дорожки на хорошо расставленной плате, и, наоборот, плохо 

расставленная плата требует длинные, запутанные дорожки или может быть даже 

нетрассируемой.  

Запустите DRC , когда компоненты будут размещены и сохраните вашу плату. 

 
Рисунок 15. Constraint manager после изменения ширины трех силовых сетей, но до 

коррекции отверстий. 

6.3 Добавление монтажных отверстий  

Большинство печатных плат должны быть установлены внутри оборудования, и поэтому 

необходимы отверстия для крепления. Монтажные отверстия и аналогичные им функции 

называются механическими символами и помещаются несколько иначе, чем электронные 

компоненты, потому что они не являются частью списка соединений.  

1. Выберите Place>Manually..., чтобы открыть диалоговое окно Placement, выберите 

вкладку Advanced Settings и выберите в Display определения из библиотеки. Это 

необходимо, поскольку символы находятся не в базе данных, импортируемых из Capture.  

2. Вернитесь на вкладку Place List и выберите Mechanical symbols из выпадающего списка.

  

3. Используйте ту же процедуру, как и раньше, чтобы разместить символ GU-

MOUNTING156 в каждом углу платы. Это отверстие диаметром 156 mils или 5/32“. Не 

ставьте отверстия слишком близко к краю или плата может сломаться, когда ее будут 

сверлить. Монтажные отверстия показаны на моей разведенной плате на рисунке 20 на 

странице 35. 

6.4 Подготовка к трассировке  

Дорожки питания, как правило, сделаны шире сигнальных дорожек, потому что они 

должны нести больший ток.  

Наши дорожки уже настолько велики, что едва ли нужно их делать шире, но мы сделаем 

это на будущее.  

1. Выберите Setup>Constraints>Physical... в строке меню. Это вызывает Constraint manager 

и Tip of the Day если вам не повезло.  

2.Левая часть окна показывает различные свойства, которые можно редактировать. 

Нажмите All Layers под Net. Смотрите рисунок 15 на предыдущей странице для 

руководства. 

3. Основная часть окна теперь показывает список сетей в вашем проекте. Большинство из 

них 

имеют случайно выглядящие цифры, например, N00451, но немногие из них названы по 

имени. Это сети, которые несут питание, которым мы, назначили имена в Capture: VCC, 



VEE и GND или 

нечто подобное, в зависимости от символа, который вы выбрали. 

4. Измените минимальную ширину для этих трех сетей от 25 до 50 мил. 

5. Выберите File>Close, чтобы вернуться в редактор печатных плат. 

Сохраните копию вашей платы перед трассировкой, чтобы вы могли использовать ее для 

двусторонней трассировки. 

 

6.5 Автотрассировка односторонней платы  
Инструментальный усилитель достаточно прост, чтобы легко развести дорожки вручную. 

Тем не менее, ручная трассировка практически невозможна для больших плат, поэтому 

мы будем использовать OrCAD PCB Router чтобы этому научиться. Вы будете делать это 

дважды: сначала для односторонней платы, как и в усилителе с одним транзистором, а 

затем для двухсторонней платы. Можно развести все дорожки на односторонней плате, 

если вы разложили ее хорошо, но двусторонняя плата должна иметь простой макет с 

меньшой общей протяженностью дорожек. Два способа доступны для автоматической 

трассировки, как показано на рисунке 3 на стр. 10. Все можно сделать из редактора 

печатных плат или вы можете запустить PCB Router в виде отдельного приложения. 

Первый способ удобнее (когда он работает), но второй предлагает более точный контроль. 

 

Автотрассировка из редактора печатных плат 

 

Выберите Route>PCB Router>Route Automatic… в строке меню. Это вызывает диалоговое 

окно Automatic Router, показанное на рисунке 16 на следующей странице. К сожалению, 

это часто вызывает сообщение фатальной ошибки похожей на SPECCTRA неожиданно 

завершает работу с кодом выхода 3, в этом случае вы должны использовать второй метод 

- перейти к следующему разделу . Выберите Use smart router for the Strategy. Для 

односторонней платы снимите флажок TOP Routing Subclass. Вы можете 

поэкспериментировать с Routing Direction для нижнего слоя. Нажмите Route и ждите 

результата. Используйте кнопку Result чтобы получить отчет о трассировке и проверьте 

процент завершения, чтобы убедиться, что все сети были проложены успешно. 

Подтвердите Display>Status... и сохраните вашу плату. Если вы не можете найти ошибки 

DRC, выберите Service>Quick Reports>DRC отчет в строке меню. Откроется таблицу со 

всеми ошибками, и гиперссылками на них. После того как все дорожки были успешно 

разведены, выберите Route>Gloss... в строке меню. Glossing «подчищает» макет. Это 

включает в себя проведение дорожек там где это возможно и замена углов 90 ° на углы 45 

° в поворотах (Mitering). Примите значения по умолчанию и подчистите свой проект. 

Наконец, используйте Tools > Quick Reports > Etch Length by Layer Report чтобы найти 

длины дорожек и добавить их. В общем, чем короче дорожки, тем лучше. 

 

Автотрассировка с OrCAD PCB Router 
 

Используйте эту инструкцию, если автоматическая трассировка не работает из PCB Editor. 

Этот способ немного неудобный, но дает лучший контроль над процессом и облегчает 

возможность поэкспериментировать с различными настройками.  



 
Рисунок 16. Диалоговое окно для запуска автотрассировщика из редактора печатных 

плат. 

 

Примечание. В какой-то момент вы можете получить предупреждение Licensing Error от 

PCB Router. Нажмите Ignore Feature for This Session, если она появится.  

1 . Выберите  File > Export > Router в строке меню редактора печатных плат. Он попросит 

ввести имя для файла автотрассировщика проекта и вы, вероятно, может принять 

предложение. Нажмите кнопку Run. Вас могут предупредить о перезаписи файла, что не 

является проблемой. Должно появиться сообщение Translation Completed, после чего вы 

можете закрыть окно. 

2 . Запустите OrCAD PCB Router из меню Пуск Windows. Откроется довольно сложное 

диалоговое окно, показанное на рисунке 17 на следующей странице. Используйте 

Browse…  чтобы открыть следующие два файла. 

• Для файла Design / Session (первый), выберите файл, который вы только что 

экспортировали из редактора печатных плат. 

• Для файла Do (последний), выбрать файл с надписью _rules, прилагаемой к имени файла 

борту платы. Нажмите кнопку Start Allegro PCB Router, чтобы закрыть окно. PCB Router 

запустится, и вы должны увидеть ваши компоненты присоединенные к ratsnest пределах 

контура Keepin. 

2) Требования к рейтинг-контролю. 

Билет №1   Фамилия Имя____________________________________________________ 

1. Метод узловых потенциалов. (5 б.) 

2. Стабилитрон. (2 б.) 

3. В чем измеряются сопротивление? (1 б.) 

4. Параллельное, последовательное соединение резисторов. (1 б.) 

 



Билет №2     Фамилия Имя____________________________________________________  

1. Полупроводники. p-n переход. (5 б.) 

2. Отрицательная обратная связь. (2 б.) 

3. Как рассчитать необходимую мощность резистора? (1 б.) 

4. Вольтамперная характеристика индуктивности. (1 б.) 

 

Билет №3     Фамилия Имя____________________________________________________ 

1. Ключ на биполярном транзисторе. (5 б.) 

2. Закон Кирхгофа для токов. (1 б.) 

3. Стандартные мощности резисторов, как обозначаются на схеме. (1 б.) 

4. Основные носители заряда в полупроводниках n–типа. (1 б.) 

Билет №4     Фамилия Имя____________________________________________________ 

1. Эмиттерный повторитель. (5 б.) 

2. Конденсаторы. (2 б.) 

3. Закон Кирхгофа для напряжений. (1 б.) 

4. Цветная маркировка резисторов (4 полосная). (1 б.) 

 

Билет №5    Фамилия Имя____________________________________________________  

1. Усилитель с общим эмиттером. (5 б.) 

2. Делитель тока. (2 б.) 

3. Какой узел называют «земля», что это означает? (1 б.) 

4. Основные носители заряда в полупроводниках n–типа.  (1 б.) 

 

Билет №6     Фамилия Имя 

1. Дифференциальный усилитель. (5 б.) 

2. Резисторы. (2 б.) 

3. Импеданс конденсатора (1 б.) 

4. Вольтамперная характеристика диода (график).  (1 б.) 

 

Билет №7     Фамилия Имя 

1. Делитель напряжения. (2 б.) 

2. Полевые транзисторы (транзистор с p-n переходом; МОП транзистор; транзистор с 

индуцированным каналом). (5 б.) 

3. Точность резисторов (допуск). (1 б.) 

4. Использование эмиттерного повторителя. (1 б.) 

 

Билет №8    Фамилия Имя____________________________________________________ 

1. Триггер Шмидта. (3 б.) 

2. Какие цепи называют квазистационарными (условие квазистационарности электрических 

цепей)? (2 б.) 

3. Биполярный транзистор n-p-n типа (принцип работы). (2 б.) 

4. Какие резисторы называют прецизионными? (1 б.) 

5. Что называют амплитудой, фазой, круговой частотой, начальной фазой гармонического 

сигнала? (1 б.) 

 

 



Билет №1     Фамилия Имя____________________________________________________ 

1. Сравнение аналогового и цифрового способов представления и передачи информации. (3 

б.) 

2. Асинхронный RS-триггеры. (2 б.) 

3. Упростить выражение с помощью карты Карно и построить схему. 
                                         

 (5 б.) 

Билет №2    Фамилия Имя____________________________________________________  

1. Цифровые сигналы. Коды. Способы передачи цифровой информации (3 б.) 

2. Асинхронный RS-триггеры. (2 б.) 

3. Упростить выражение с помощью карты Карно и построить схему. (5 б.) 
                                           

Билет №3     Фамилия Имя____________________________________________________ 

1. Элементарные логические функции и соответствующие им цифровые элементы. Теоремы 

булевой алгебры. Теоремы де Моргана. (3 б.) 

2. Статический RS- триггер. (2 б.) 

3. Упростить выражение с помощью карты Карно и построить схему. 
                                         

 (5 б.) 

Билет №4     Фамилия Имя____________________________________________________  

1. ТТЛ(Ш) и КМОП микросхемы. (3 б.) 

2. Статический D- триггер. (2 б.) 

3. Упростить выражение с помощью карты Карно и построить схему. 
                                              

 (5 б.) 

Билет №5     Фамилия Имя____________________________________________________  

1. Комбинационные схемы. Карты Карно (3 б.) 

2. Динамические триггеры. MS-триггеры. (RS). (2 б.) 

3. Упростить выражение с помощью карты Карно и построить схему. 
                                              

 (5 б.) 

Билет №6     Фамилия Имя____________________________________________________   

1. Комбинационные схемы. Карты Карно (3 б.) 

2. Динамические триггеры. MS-триггеры. (D). (2 б.) 

3. Упростить выражение с помощью карты Карно и построить схему. 
                                               

 (5 б.) 

Билет №7     Фамилия Имя____________________________________________________   

1. Последовательные схемы. Триггеры. (3 б.) 

2. Динамические триггеры. MS-триггеры. (T). (2 б.) 

3. Упростить выражение с помощью карты Карно и построить схему. 
                                             

 (5 б.) 



Билет №8     Фамилия Имя____________________________________________________  

1. Последовательные схемы. Асинхронные счётчики. (3 б.) 

2. Универсальный JK-триггер. (2 б.) 

3. Упростить выражение с помощью карты Карно и построить схему.  
                                          

(5 б.) 

 

VIII. Перечень педагогических и информационных технологий, используемых при 

осуществлении образовательного процесса по дисциплине, включая перечень 

программного обеспечения и информационных справочных систем (по 

необходимости) 
1. Cadence SPB/OrCAD 16.6. 

4. Microsoft Office 365 pro plus 

5. Microsoft Windows 10 Enterprize 

6. Google Chrome 

7. Origin 8.1 Sr2 

 

IХ. Материально-техническая база, необходимая для осуществления 

образовательного процесса по дисциплине 

Базовая учебная 

лаборатория общей 

физики. 

Лаборатория 

электроники и 

микропроцессорной 

техники № 202 А 

(170002 Тверская 

обл., г. Тверь, 

Садовый пер., д. 35) 

1 Ноутбук ASUS N53SM 

2 Ноутбук ASUS N53SM 

3 Компьютер Ramec \ Монитор 

AOS E2250Swda\кл-

ра\мышь\коврик 

4 Компьютер Ramec\ Монитор 

AOC E2250Swda\ кл-

ра\мышь\коврик 

5 Компьютер Ramec\ Монитор 

AOC E2250Swda\ кл-

ра\мышь\коврик 

6 Компьютер Ramec\ Монитор 

AOC E2250Swda\ кл-

ра\мышь\коврик 

7 Компьютер Ramec\ Монитор 

AOC E2250Swda\кл-

ра\мышь\коврик 

8 Компьютер Ramec\ Монитор 

AOC E2250Swda\кл-

ра\мышь\коврик 

9 Компьютер Ramec\ Монитор 

AOC E2250Swda\кл-

ра\мышь\коврик 

10 Монитор 15" TFT Proview 

11 Принтер лазерный HPLJ 1000 

W Q1342A 

12 Компьютер (сист. блок, 

монитор AOC 23" E2350Sda, кл-ра, 

мышь) 

13 Внешний жесткий диск 

Transcend 1Gb 

14 Сист.блок HELiOS Profice 

VL310 In P2GHz.256Mb/40GB/CD-

Google Chrome – бесплатно 

Kaspersky Endpoint Security 

10 для Windows – Акт на 

передачу прав №2129 от 25 

октября 2016 г. 

MS Office 365 pro plus - Акт 

приема-передачи № 369 от 

21 июля 2017 

Microsoft Windows 10 

Enterprise - Акт приема-

передачи № 369 от 21 июля 

2017 

 



ROM 3.5.клавиатура,мышь 

оптическая (ПО Mic Win XP Prof 

,Mc Off 200 

15 Антистатическая мебель 

1300488-00 

16 Антистатическое оборудование 

1300488-00 

17 Графическая среда разработки 

приложений 1300488-00 

18 Комплект паяльного 

оборудования на базе 

производства PACE 1300488-00 

19 Инструмент на базе 

оборудования 

Tronex,Xcelite,Bernstein 1300488-

00 

20 Осветительное оборудование на 

базе оборудования Lamp-Zoom 

1300488-00 

21 Программное обеспечение 

Circuit 1300488-00 

22 Лабораторная платформа для 

проектирования и моделирования 

электронных схем NI ELVIS II 

Circuit Design Bundle (комплект из 

6 лаб. платформ) 

 

Компьютерный 

класс № 216 

(170002 Тверская 

обл., г. Тверь, 

Садовый пер., д. 35) 

1. Компьютер INT Allegro, 

монитор Benq 24" GL2460 – 10 шт. 

2. Коммутатор D-Link DGS-1008D 

3. Коммутатор D-Link DGS-1008D 

4. Проектор Beng MW523 DLP с 

потолочным креплением и 

проекционным экраном 

5. Комплект учебной мебели 

Google Chrome – бесплатно 

Kaspersky Endpoint Security 

10 для Windows – Акт на 

передачу прав №2129 от 25 

октября 2016 г. 

MS Office 365 pro plus - Акт 

приема-передачи № 369 от 

21 июля 2017 

Microsoft Windows 10 

Enterprise - Акт приема-

передачи № 369 от 21 июля 

2017 

Помещения для самостоятельной работы: 

Наименование 

помещений  

Оснащенность помещений для 

самостоятельной работы 

Перечень лицензионного 

программного обеспечения.  

Реквизиты 

подтверждающего документа 

Помещение для 

самостоятельной 

работы, учебная 

аудитория для 

проведения занятий 

лекционного типа, 

занятий 

семинарского типа, 

1. Компьютер RAMEC STORM  

C2D 4600/160Gb/ 256mB/DVD-

RW +Монитор LG TFT 17" 

L1753S-SF – 12 шт 

2. Мультимедийный комплект 

учебного класса (вариант № 2) 

Проектор Casio XJ-M140, 

Adobe Acrobat Reader DC - 

бесплатно 

Cadence SPB/OrCAD 16.6 - 

Государственный контракт на 

поставку лицензионных 

программных продуктов 103 - 

ГК/09 от 15.06.2009 

Google Chrome - бесплатно 



курсового 

проектирования 

(выполнения 

курсовых работ), 

групповых и 

индивидуальных 

консультаций, 

текущего контроля 

и промежуточной 

аттестации, 

практики,  

Компьютерный 

класс физико-

технического 

факультета. 

Компьютерная 

лаборатория 

робототехнических 

систем №4а 

(170002 Тверская 

обл., г. Тверь, 

Садовый пер., д. 35) 

 

 

настенный проекц. экран Lumien 

180*180. ноутбук Dell N4050. 

сумка 15,6", мышь 

3. Коммутатор D-Link 

10/100/1000mbps 16-potr DGS-

1016D 

4. Видеокамера IP-FALCON EYE 

FE-IPC-BL200P, ОнЛайн Трейд 

ООО 

5. Видеокамера IP-FALCON EYE 

FE-IPC-BL200P, ОнЛайн Трейд 

ООО 

6. Демонстрационное 

оборудование комплект 

«LegoMidstormsEV3» 

7. Комплект учебной мебели 

 

Java SE Development Kit 8 Update 

45 (64-bit) - бесплатно  

Kaspersky Endpoint Security 10 для 

Windows – Акт на передачу прав 

№2129 от 25 октября 2016 г. 

Lazarus 1.4.0 - бесплатно 

Lego MINDSTORM EV3 - 

бесплатно 

Mathcad 15 M010 - Акт 

предоставления прав ИС00000027 

от 16.09.2011 

MATLAB R2012b - Акт 

предоставления прав № Us000311 

от 25.09.2012 

Microsoft Express Studio 4 - 

бесплатно 

MiKTeX 2.9 - бесплатно 

MPICH 64-bit – бесплатно 

MSXML 4.0 SP2 Parser and SDK - 

бесплатно 

Microsoft Windows 10 Enterprise - 

Акт приема-передачи № 369 от 21 

июля 2017 

MS Office 365 pro plus - Акт 

приема-передачи № 369 от 21 

июля 2017 
 

X. Сведения об обновлении рабочей программы дисциплины  

№ 

п.п. 

Обновленный 

раздел рабочей 

программы 

дисциплины 

(модуля) 

Описание внесенных изменений 

Дата и протокол 

заседания, 

утвердившего 

изменения 

1 Раздел IV Скорректирован фонд оценочных 

средств для проверки уровня 

сформированности закрепленных за 

дисциплиной компетенций  

Протокол Совета ФТФ 

№5 от 31 октября 2017 г 

2 Раздел IV Скорректированы задания для 

промежуточной аттестации в 

соответствии с обновленным 

«Положением о промежуточной 

аттестации (экзаменах и зачетах) 

студентов ТвГУ» 

Протокол Совета ФТФ 

№5 от 31 октября 2017 г. 

3 Раздел V  Обновлен перечень основной и 

дополнительной учебной литературы, 

необходимой для освоения 

дисциплины 

Протокол Совета ФТФ 

№5 от 31 октября 2017 г 

4 Раздел  IX Оснащенность аудиторного фонда 

для проведения учебных занятий и 

самостоятельной работы студентов 

согласно «Справки МТО ООП …» 

Протокол Совета ФТФ 

№5 от 31 октября 2017 г 

5 Раздел I, II Внесены изменения в объем и Протокол Совета ФТФ 



содержание дисциплины в связи с 

изменениями учебного плана ООП 

по направлению 03.04.03 

Радиофизика 

№5 от 11 декабря 2018 г 

6 Раздел IV Скорректирован фонд оценочных 

средств для проверки уровня 

сформированности закрепленных за 

дисциплиной компетенций 

Протокол Совета ФТФ № 

6 от 15.01.2019 г. 

7 Раздел IV Внесены изменения в соответствии с 

«Положением о промежуточной 

аттестации (экзаменах и зачетах) 

обучающихся по программам 

высшего образования ТвГУ» 

Протокол Совета ФТФ № 

10 от 19.05.2020 г. 

8 Раздел IV Внесены изменения в соответствии с 

«Положением о рейтинговой системе 

обучения в ТвГУ» 

Протокол Совета ФТФ № 

10 от 19.05.2020 г. 

9 Титульный лист Внесены изменения на титульном 

листе: ФИО руководителя ООП 

Приказ 1382-О от 

01.10.2021 «О 

назначении 

руководителей 

образовательных 

программ» 

 

 


